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Dear Student Innovators 

“We need to turn the recovery into a real opportunity to do things 

right for the future.” 

So here are some guidelines for the Summer Assignments. Follow 

them sincerely and let creativity flow in air: 

✓ All Summer Assignments should be done in subject 

notebooks / A-4 sheets /project files, as per the instructions 

given by Subject Teacher. 

✓ Do it in a neat and presentable manner. 

✓ Original work of students will receive greater recognition 

and appreciation. 

✓ These assignments carry extra marks in Internal Assessment 

(Subject Enrichment). 

✓ Read and revise all the subjects covered till date. 

✓ Hence, submission of work is compulsory for all students. 

 



 

 

COMPETENCY BASED QUESTIONS 

 
Q1. Lencho waited eagerly for a reply to his letter to God. Do you think the postmaster was also very 

keen to know Lencho’s reaction upon receiving the ‘reply'? 

 
Q2. Lencho did not bother exploring any other means to resolve his situation but just turned to God. 

Do you feel that his approach was justified? Why/Why not? 

 
Q3 Briefly state the promise that Mandela made at the beginning of Oath taking speech. 

 
Q4. Mandela believed that the oppressor must be liberated just as surely as the oppressed. Justify. 

 
Q5. The poem ‘Dust of Snow' evokes a sense of black and white. Justify. 

 
Q6. ’Fire and Ice' project a pessimistic outlook. Comment. 

 
Q7. Was Tricky suffering from any ailment in reality? If not, then what made him inactive and 

lethargic? 

 
UNDERSTANDING BASED 

 
Q1. Where was Lencho’s house situated? Why did he sit seeing the sky? 

 
Q2. What did freedom mean to Mandela in childhood? 

 
Q3. What is the significance of the symbols used in the poem ‘Fire and Ice' by Robert Frost? 

 

Q4. What do you understand by ‘apartheid’?  

 

Q5. The ‘Dust of Snow' changed the poet's mood. How?  

 

APPLICATION / EXTRAPOLATION-BASED QUESTION 

 

Q1. Read the following quote by Mahatma Gandhi. 

“It is health that is real wealth not, pieces of gold and silver.” 

Justify the quote given above in light of Tricki's sickness and his recovery to be fit. 

 

 

Q2. Based on your understanding of the story and the characters, develop a conversation 

between the postmaster and the post office employees after reading Lencho’s letter to 

‘God’. 

 

Q3. Create a tagline/ slogan/catchy phrase for the following chapters: 

▪ A letter to God 

ENGLISH 



▪ Nelson Mandela: Long Walk for Freedom 

▪ Dust of snow 

▪ Fire and Ice 

▪ The triumph of surgery  

 

WRITING SKILLS 

 

Q1. You are Manish Kumar, president of the NGO JYOTI. Write a letter to the editor of a 

national daily highlighting the issue of your neighbourhood being dirty for a long time and 

even after complaining to the Municipality, they didn’t take any action. 

(100- 120words) 

 

Q2. The chart shows the division of household tasks by gender in Great Britain. Write an 

analytical paragraph describing the chart given in not more than 100-120 words. 

 

 

 

ASSESSMENT OF LISTENING AND SPEAKING (ASL) 

 

Q Prepare yourself on any two topics of your choice for ASL. 

 

ART INTEGRATED PROJECT 

 

Q1. Paint the poem ‘Dust of Snow by using Thumb Impressions. (Thumb painting) 

 

Q2. Make some bookmarks (Minimum two). Decorate them beautifully with quotes of Nelson 

Mandela 

 

 

 

 

 



 

 

 

Q.1 Find the zeroes of the following quadratic polynomials and verify the relationship between the 

zeroes and the coefficients. 

(i) 2x2+7/2x +3/4                          (ii)  5t2 +12t +7 

Q.2 Find a quadratic polynomial each with given numbers as the sum and product of its zeroes 

respectively.  

(i) √2  ,-3/2                                 (ii)    -4/3    ,0 

Q.4 Find the HCF and LCM of 96 and 404 by prime factorization method. 

 

Q.5 The LCM of two numbers is 2079 and their HCF is 27, if one of the numbers is 189. Find the 

other. 

 

Q.6 The age of the two friends Ram and Biju differ by 3 years Ram’s father Dharam is twice as old 

as Ram and Biju is twice as old as his sister Cathy. The ages of Cathy and Dharam differ by 

30 years. Find the ages of Ram and Biju.  

 

Q.7 Find the value of k for which the quadratic equation (3k+1)x2 +2(k+1)x +1=0 has equal roots. 

Also, find these roots.  

 

Q.8 Check whether 6n can end with the digit zero for any natural number n. 

 

Q.9 
Prove that √5 is an irrational number. 

 

Q.10 
Prove that √3+√5 is an irrational number. 

 

Q11 On a morning walk, three persons step together and their steps measure 40 cm,42cm and 45 cm, 

respectively. What is the minimum distance each should walk so that each can cover the 

same distance in complete steps? 

 

Q.12 If α and β are the zeroes of the polynomial 3x2 -8x +4. Find the values of : 

(i) α2 + β2                       (ii) 1/α  +1/β 

 

Q.13  For which value of K will be the following pair of linear equations have no solution 

       3x + y = 9, (2k – 1)x + (k – 1)y = 2k + 1  

 

Q.14 Draw the graph of 2x + y = 6 and 2x – y = -2. Shade the region bounded by these lines and x–

axis. Find the area of the shaded region. 

 

Q.15 Three consecutive multiples of 3(all natural numbers) have a sum of their squares equal to 261. 

Find the numbers. 

 

MATHEMATICS 



Q.16 Three consecutive multiples of 3(all natural numbers) have a sum of their squares equal to 261. 

Find the numbers. 

 

Q.17 The numerator of a fraction is 4 less than the denominator. If the numerator is decreased by 2 and 

the denominator is increased by 1, then the denominator is eight times the numerator. Find 

the fraction.  

 

Q.18 From a well-shuffled pack of cards, a card is drawn at random. Find the probability of getting a 

black queen. 

Q.19        A box contains 5 red marbles, 8 white marbles and 4 green. One marble is taken out of the 

box at random. What is the probability that the marble taken out will be: 

          (i) red (ii) white (iii) not green                                                                                                             

         

Q.20 If α and β are the zeroes of the polynomial kx2 +4x +4 and α2 +β2 =24. Find the value of k.

  

Q21 If the product of zeroes of the polynomial ax2-6x-6 is 4, find the values of a.  

Q22 5 years ago, a man was thrice as old as his son and ten years later he will be twice as old as his 

son. Find the present ages of the man and his son.   

Q.23 The sum of two-digit numbers and the number formed by interchanging the digits is 110. If 10 is 

subtracted from the first number, the new number is 4 more than 5 times the sum of the digits 

in the first number. Find the first number.      

Q24 The age of the father is twice the sum of the ages of his two children. After two years, his age will 

be equal to the sum of the ages of his children. Find the age of the father. 

Q.25  A and B together have 45 marbles. Both lost 5 marbles each, and the product of the marbles they 

now have is 124. Find the number of marbles each had originally. 

Q.26  Harpreet tosses two coins. What is the probability that she gets at least one head? 

 

Q.27  Case study  1 Asana is a body posture, originally and still a general term for a sitting 

meditation poses, and later extended in hatha yoga and modern yoga as exercise, to any 

type of pose or position, adding reclining, standing, inverted, twisting, and balancing poses. 

In the figure, one can observe that poses can be related to the representation of quadratic 

polynomials. 

 

 

 

 

 

 

 

 

 

 

 



 

1. The shape of the poses shown is 

a) Spiral, b) Ellipse, c) Linear, d) Parabola 

2. The graph of the parabola opens downwards, if _______ 

a) a ≥ 0  b) a = 0 

c) a < 0  d) a > 0 

3. In the graph, how many zeroes are there for the polynomial? 

 

 

a) 0    b) 1 

c) 2    d) 3 

 
 
4. The two zeroes in the above-shown graph are 

a) 2, 4       b) -2, 4 

c) -8, 4       d) 2, -8 

Q.28 Case study-2 

 India is a competitive manufacturing location due to the low cost of manpower and strong 

technical and engineering capabilities contributing to higher quality production runs. The 

production of TV sets in a factory increases uniformly by a fixed number every year. It 

produced 16000 sets in the 6th year and 22600 in the 9th year. 

 
Based on the above information, answer the following questions: 

1. Find the production during the first year. 

2. Find the production during the 8th year. 

3. Find the production during the first 3 years. 

4. In which year, the production is Rs 29,200. 

5. Find the difference in the production during the 7th year and 4th year. 

 ART INTEGRATED PROJECT 

1 Draw a Wali Art on A 4 sheet by using triangles, circles and lines. 

2. Draw a Mandola Art on an A4 sheet by using a geometrical shape.  
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• FOR STUDENTS- 

*Please maintain the quality of work done. 

• Holiday homework will be assessed on parameters --Neatness and presentation, marks/grades will be 

awarded accordingly. 

• Read NCERT chapters thoroughly and make optimum use of the practice manual. 

• Highlight areas of doubt and clarify with the teachers after vacation. 

• Minimise the use of gadgets 

*Learn the Reactivity series 

 

CHEMISTRY 
 

MULTIPLE CHOICE QUESTIONS: 
 

 
Q1 

LOTS: 

Oxidation is a process which involves 

(a) addition of oxygen 

(b) addition of hydrogen 

(c) removal of oxygen 

(d) removal of hydrogen 
Q2  Nettle sting is a natural source of which acid? 

(a) Meti Wanoic acid 

(b) Lactic acid 

(c) Citric acid 

(d) Tartaric acid 
Q3 An aqueous solution ‘A’ turns the phenolphthalein 

solution pink. On the addition of an aqueous solution 

‘B’ to ‘A’ the pink colour disappears. The following 

statement is true for solutions ‘A’ and ‘B’: 

(a) A is strongly basic and B is a weak base. 

(b) A is strongly acidic and B is a weak acid.                                  

(c) A has pH greater than 7 and B has pH less than 7. 

(d) A has pH less than 7 and B has pH greater than 7  

Q4  In terms of acidic strength, which one of the following 

is in the correct increasing order? 

(a) Water < Acetic acid < Hydrochloric acid 

(b) Water < Hydrochloric acid < Acetic acid 

(c) Acetic acid < Water < Hydrochloric acid 

(d) Hydrochloric acid < Water < Acetic acid                                 

  
Q5 Na2CO3.10H2O is: 

(a) washing soda 

(b) baking soda 

SCIENCE 

 



(c) bleaching powder 

(d) tartaric acid 

 
 
 
 
Q6 

                            ASSERTION-BASED QUESTIONS: 

Direction: In the questions given below, there are two statements marked as Assertion(A) and 

Reason(R). 

Read the statements and choose the correct option. 

(a) Both A and R are true, and R is the correct explanation of A. 

(b) Both A and R are true, but R is not the correct explanation of A. 

(c) A is true but R is false. 

(d) A is false but R is true 

 

(i) Assertion(A): The number of atoms of each element remains the same, before and after a 

chemical reaction. 

Reason(R): Any chemical equation can be unbalanced because the mass may not be the same on 

both sides of the equation. 

  

(ii) Assertion(A): Brown fumes are obtained from the thermal decomposition of Lead Nitrate. 

Reason(R): Nitrogen dioxide gas is released which is brown in colour. 

 

 (iii) Assertion(A): Silver Bromide is used in black and white photography. 

Reason(R): Silver Bromide decomposes in the presence of sunlight. 

 
 
Q7 
 
 
 

HOTS 

What is observed when carbon dioxide gas is passed through lime water: for a short duration? 

Also, write the chemical equations for the reactions involved 

Q8 (a) It has been found that the marble of the Taj are getting corroded due to the development of 

industrial areas around it. Explain this fact by giving a chemical equation. 

(b) Taj Mahal, one of the seven wonders of the world situated at Agra, is continuously losing its 

lustre day by day due to rapid industrialisation which causes acid rain. 

 
Q9 A compound P forms the enamel of teeth. It is the hardest substance in the body. It doesn’t dissolve 

in water but gets corroded when the pH is lowered below 5.5. 

(a) Identify the compound P. 

(b) How does it undergo damage due to eating chocolate and sweets? What should we do to 

prevent tooth decay?  

(ii) Balance the following chemical equations: 

(a) HNO3 + Ca (OH)2 → Ca (NO3)2 + H2O 

(b) NaOH + H2SO4 → Na2SO4 + H2O 

(c) NaCl + AgNO3 → AgCl + NaNO3 

(d) BaCl2 + H2SO4 → BaSO4 + HCl 

 

PHYSICS 

 
 
Q1 

 

PROJECT: Make a Model to show how an electric motor converts electrical energy into 

mechanical energy. 

The refractive index of carbon disulphide is 1.63.’ What is the meaning of this statement in relation 

to the speed of light?  

 

Q2 A doctor has prescribed a corrective lens of power +1.5 D. Find the focal length of the lens. Is the 

prescribed lens diverging or converging? 

 



Q3 ‘The refractive index of carbon disulphide is 1.63.’ What is the meaning of this statement in 

relation to the speed of light?  

 

Q4   (a) What is meant by ‘power of a lens’? 

(b) State and define the S.I. unit of power of a lens. 

(c) A convex lens of focal length 25 cm and a concave lens of focal length 15 cm are placed in 

close contact with each other. Calculate the lens power of this combination. 

 

Q5 Prove that if a ray of light enters a rectangular glass slab obliquely and emerges from the opposite 

face of the glass slab, the emergent ray will be parallel to the incident ray. 

 

Q6 One day Atul told Rohit to show magic he focused the rays of sunlight on the bare arm of Rohit. 

After a few seconds, Rohit felt pain and removed his arm away. Atul was laughing at Rohit. 

(a) Name the type of lens Atul had. 

(b) Why did Rohit feel pain? 

(c) What kind of mirrors are used in big shopping stores to watch the activities of customers? 

 

Q7 (a)An object of size 7.0 cm is placed at 27 cm in front of a concave mirror of a focal length of 18 

cm. At what distance from the mirror should a screen be placed, so that a sharp focused image can 

be obtained? Find the size and the nature of the image. 

(b) An object 50 cm tall is placed on the principal axis of a convex lens. Its 20 cm tall image is 

formed on the screen placed at a distance of 10 cm from the lens. Calculate the focal length of the 

lens. 

 

Q8 Rahul along with his younger brother went to an amusement park. There, they entered a small hall 

with full mirrors. They looked very funny in large-size mirrors. In front of one of the mirrors. Their 

faces were normal, their bellies were fat, and their legs were short. Rahul’s younger brother was 

frightened and tried to hit the mirror with his foot. However, Rahul stopped him to do so. 

(a) Name the type of mirror in front of which Rahul and his brother were standing? 

(b) What is the cause of the distortion of their images? 

(c) Name the type of mirror used in a solar furnace. How is high temperature achieved by 

this device?  

 

Q9 ASSERTION BASED QUESTIONS 

Q9 Direction In each of the following questions, a statement of Assertion is given by the 

corresponding statement of Reason. Of the statements, mark the correct answer as 

(a) If both Assertion and Reason are true and Reason is the correct explanation of Assertion. 

(b) If both Assertion and Reason are true, but Reason is not the correct explanation of Assertion. 

(c) If Assertion is true, but Reason is false. 

(d) If Assertion is false, but Reason is true. 

(e) If Assertion and Reason both are false. 

(i) Assertion: Convex mirror is preferred for rear-view mirrors in vehicles. 

 Reason: The field view of a convex mirror is lesser than that of a concave mirror. 

(iI) Assertion: Lateral displacement is the distance between the incident ray and the emergent ray. 

 Reason: The wider the glass slab, the larger the lateral displacement. 
 

BIOLOGY 

Q1  
 
 

.In which of the following groups of organisms are food materials broken down outside the body 

and absorbed? 

(a) Mushroom, green plants, amoeba 

(b) Yeast, mushroom, bread mould 

(c) Paramecium, amoeba, cuscuta 

(d) Cuscuta, lice, tapeworm 

 



Q2 The contraction and expansion movement of the walls of the food pipe is called: 

(a) Translocation 

(b) Transpiration 

(c) Peristaltic movement 

(d) Digestion 

Q3 What are the products obtained by anaerobic respiration in plants? 

(a) Lactic acid + energy 

(b) Carbon dioxide + water + energy 

(c) Ethanol + carbon dioxide + energy 

(d) Pyruvate 

Q4 When a few drops of iodine solution are added to rice water, the solution turns blue-black in 

colour. This indicates that rice water contains: 

(a) Fats 

(b) Complex proteins 

(c) Starch 

(d) Simple proteins 

 

 

Q5.  

Which of the equations shows the correct conversion of CO2 and H2O into carbohydrates in 

plants? 

 

 
Q6 The characteristic processes observed in anaerobic respiration are: 

i) Presence of oxygen 

ii) Release of carbon dioxide 

iii) Release of energy 

iv) Release of lactic acid 

(a) i), ii) only 

(b) i), ii), iii) only 

(c) ii), iii), iv) only 

(d) iv) only 
Q7 The opening and closing of the stomatal pore depend upon: 

(a) Oxygen 

(b) Temperature 

(c) Water in the guard cells 

(d) Concentration of CO2 

Q8 ASSERTION AND REASON . 

Both A and R are true, and R is the correct explanation for A 

b) Both A and R are true and R is not the correct explanation for A 

c) A is true but R is false 

d) A is false but R is true 

  



1) ASSERTION (A): Energy is required to carry out different life processes. 

REASON(R): Energy is obtained in the form of ATP in the mitochondria. 

 2) ASSERTION (A): Aerobic respiration require less energy as compared to anaerobic respiration. 

REASON(R): Mitochondria is the powerhouse of the cell. 

 3) ASSERTION (A): Capillaries have walls that are just one cell thick. 

Reason (R): Exchange of material between the blood and surrounding cells takes place 

across the capillaries. 

 
Q9 List the three kinds of blood vessels of human circulatory system and write their functions in tabular form. 

 

Q10 (a)  "The breathing cycle is rhythmic whereas the exchange 

of gases is a continuous process". Justify this statement. 

(b)  What happens if conducting tubes of the circulatory 

system develop a leak? State in brief, how could this be 

avoided? 

(c)  How opening and closing of stomata takes place 

 
 

Q11 Draw a diagram of the front view of the human heart and label any six parts including at least two that are 

concerned with arterial blood supply to the heart muscles. 

 

Q12 Describe in brief the function of kidneys, ureters, urinary bladder and urethra.                                  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

HISTORY 

TOPIC-THE RISE OF NATIONALISM IN EUROPE 

 

MULTIPLE CHOICE QUESTIONS: 

1  Who made the famous remark ‘When France sneezes, the rest of Europe catches cold’? 

 a) Metternich 

b) Mazzini 

c) Garibaldi 

   d) Louis Philippe 

2 

 

The Treaty of Constantinople was signed in _______. 

 a) 1835 

b) 1735 

c) 1834 

   d) 1833 

3 Giuseppe Mazzini founded the secret underground society named ‘Young Europe’ in __________. 

 a) Marseilles 

b) Berne 

c) Vienna 

d) Brussels  

 

4 _________ believed that established, traditional institutions of state and society should be preserved. 

 a) Conservatives 

b) Liberals 

c) Democrats 

   d) None of the above 

5 The Bourbon dynasty, which had been deposed during the French Revolution, was restored to power 

after signing the Treaty of _______. 

 a) Vienna 

b) Constantinople 

c) Marseilles 

   d) Prussia 

MAP WORK 

 

 On the political Map of Europe, locate & name the following countries-        

✓ Britain 

✓ France 

✓ Germany 

✓ Italy 

✓ Austria 

✓ Poland 

 

 

SOCIAL SCIENCE 



(POLITICAL SCIENCE) 

TOPIC – POWER-SHARING 

 1) Belgium has borders with France, the Netherlands, ________ and Luxembourg. 

 a) Sweden 

b) Austria 

c) Italy 

d) Germany 

 2) _________ is a violent conflict between opposing groups within a country that becomes so intense 

that it appears like a war. 

 a) Civil war 

b) Proxy war 

c) colonial war 

d) None of the above 

 3) Which of the following statements is true? 

a) A legitimate government is one where citizens, through participation, acquire a stake in the system. 

b) Prudential reasons stress that power-sharing will bring out better outcomes; moral reasons emphasize 

the very act of power-sharing as valuable. 

c) A democratic rule involves sharing power with those affected by its exercise and who have to live 

with its effects. 

d) All of the above 

 4) In the island nation of Sri Lanka, the Sri Lankan Tamil population is concentrated in the _______ 

and _____ of the country.  

a) South and West 

b) South and East 

c) North and Central 

  d) North and East 

 5) Most of the Sinhala-speaking people of Sri Lanka are ______. 

   a) Christians 

b) Hindus 

c) Buddhists 

   d) Muslims 

PROJECT WORK 

 

Make a list of Schedule Languages of India (Political Science Text Book Page no.-22) and do the 

following: 

 ➢ Make a bar or pie chart on the basis of this information. 

➢ Prepare a map of the linguistic diversity of India by shading the region where each of these 

languages is spoken on the map of India. 

➢ Find out about any three languages that are spoken in India but are not included in this list. 

 

GEOGRAPHY 

TOPIC: RESOURCES AND DEVELOPMENT 

Q1 Read the text given below and answer the following questions: 

In June 1992, more than 100 heads of states met in Rio-de-Janeiro in Brazil, for the first international 

Earth summit. The summit was convened to address urgent problems of environmental protection and 

socio-economic development at the global level. The assembled leaders signed the Declaration on 



Global Climatic Change and Biological Diversity. The Rio Convention endorsed the global Forest 

Principles and adopted Agenda 21 for achieving Sustainable Development in the 21st century. 

Answer the following MCQs by choosing the most appropriate option: 

 1. The so-called first international Earth summit was convened for:                            

(a) addressing urgent problems of environmental protection. 

(b) addressing socio-economic development at the global level. 

(c) Both (a) and (b) 

(d) None of the above 

 

 2 The passage is mainly related to:                                                                                   

(a) Global climatic change 

(b) Rio-de-Janeiro Earth Summit 1992 

(c) Sustainable development  

(d) Agenda 21 

 

 3.  Agenda 21 is the flowchart of action to be taken by the assembled nations to:   

(a) achieve environmental protection. 

(b) fulfil the needs of future generations. 

(c) combat the hurdles that debar sustainable development. 

(d) attain socio-economic development at the global level. 

 

 4. The term used to achieve development without damaging the environment and without compromising 

the needs of future generations is:                             

(a) socio-economic development 

(b) Agenda 21 

(c) Global environmental development 

(d) Sustainable development 

 

Q2 ‘Resource is a function of human activities’ Justify the statement. 

Q3 List the problems which resulted due to the indiscriminate use of resources by man. 

Q4 Write a note on good practices towards conserving natural resources. 

Q5 From your everyday experiences write a short proposal on how you can conserve water. 

 

 
 Identify the types of soil marked on the above-mentioned map. 

 

 

 
 



ECONOMICS 

TOPIC – DEVELOPMENT 
 

1 Why does Kerala have a low infant mortality rate? 

2 How is the average income of a country calculated? 

3 How Will We Calculate Body Mass Index? 

4 In Tamil Nadu, 90 per cent of the people living in rural areas use a ration shop, whereas in West Bengal 

only 35 per cent of rural people do so. Where would people be better off and why? 

5 Can you guess why around 1/5 of people in the country are undernourished even though it is argued that 

there is enough food in the country? Describe in your own words. 

6 Calculate the Body Mass Index of your family members. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

Employability Skills 

 
Objective Type Questions 

 
1 Which of the following is NOT an element of communication within the communication process 

cycle? 

a. Channel 

b. Receiver 

c. Sender 

d. Time 

 

2 Which of the following is an example of oral communication? 

a. Newspapers 

b. Letters 

c. Phone call 

d. e-mail 

 

3 Which of these are examples of positive feedback? 

a. Excellent, your work has improved. 

b. I noticed your dedication towards the project. 

c. You are always doing it the right way. 

d. All of the above 

4 Identify the measure to protect computers from threats and viruses: 

a. Sharing passwords with friends 

b. Allow anyone to use your device 

c. Use Antivirus 

d. Leave the computer without logging out 

5 Here are the steps that take place when starting a computer. Rearrange the steps in the correct 

order. 

(i) Desktop appears after login 

(ii) Login screen appears 

(iii) Power on Self-Test (POST) starts 

(iv) Operating System starts 

(v) Welcome screen appears 

a.  (i) -> (ii) -> (iii) -> (iv) -> (v) 

b.  (ii) -> (iv) -> (iii) -> (v) -> (i) 

c.  (iii) -> (iv) -> (v) -> (ii) -> (i) 

d.  (iii) -> (v) -> (iv) -> (ii) -> (i) 

 

Subjective Questions 

 
6 What is the role of Feedback in communication process? 

7 Explain 7C’s of effective communication. 

8 What is the significance of Recycle Bin? Explain 

INFORMATION TECHNOLOGY (402) 

 



 

Digital Documentation 

 
Objective type questions 

 
1 __________ styles in a text document affect the selected text within a paragraph, such as the font 

and size of text, or bold and italic format. 

 

a. Cell 

b. Paragraph 

c. Formatting 

d. Character 

2 Prisha is a book editor. She wants to change the indentation of all paragraphs and change the font 

of all titles in the book. Which feature she should use to make the task easy? 

a. Styles 

b. Templates 

c. Table of contents 

d. None of these 

 

3 Removing unwanted area from an image is known as __________ of an image. 

a. Tiling 

b. Redrawing 

c. Cropping 

d. Deleting 
4 In a document, ______________ refers to the vertical or horizontal placement of a graphic in 

relation to the chosen anchor point. 

a. Arrangement 

b. Anchoring 

c. Alignment 

d. Text Wrapping 
5 Identify the command used to create a table of contents on Open Office Writer. 

a. File -> New -> TOC 

b. File -> Create -> TOC 

c. Insert -> Table of Contents 

d. Insert -> Indexes and Tables -> Entry 
Subjective Questions: 

 
6 Explain the use of the Mail Merge feature available in word processors. 

 

7 Name the different categories of styles in writing. 

 
8 What is the utility of Fill Format mode? 

 

9 What is the utility of Fill Format mode? 

 

 

 

 

 



ह िंदी – अ  
प्रश्न 1 1-पाठ’नतेाजी का चश्मा’ में से सरल, सिंयकु्त 

और ममश्र वाक्य (5-5) छािंटकर मलखिए। 

 

 
उदा रण- नेताजी फौजी वर्दी में स ुंर्दर लग रहे थे। 

प्रश्न-2- ननदेशानुसार वाक्य पररवनतित कररए- 

गली में शोर होने पर सब लोग बाहर आ गए। 

(ममश्र) 

वह आया परंतु कुछ नही ंबोला। (सरल) 

वह कल यहााँ आया और सब से बात कर के 

चला गया। (सरल) 

दहाड़ते शेर ने महरन पर हमला मकया। 

(संयुक्त) 

जब मैंने बालक को रोते हुए देखा, तो उससे 

कारण पूछा। (संयुक्त) 

 

 

प्रश्न-3 रचना के आधार पर वाक्य के मकतने भेद है? 

उदाहरण समहत मलखखए। 
 

उदा रण- जब घर से ननकला तब वर्ाा ह ई। 

  प्रश्न-4  -नेताजी का चश्मा 

क-आपके शहर में नगर पामलका/ नगर 

मनगम क्या-क्या कायय करवाती है है ?आप की 

उसमें क्या भूममका हो सकती है? 

-ख-चौराहो ंपर महापुरुषो ंकी मूमतययां लगााने 

के पीछे क्या उदे्दश्य हो सकते है? उनके प्रमत 

आप अपने कतयव्य मलखखए। 
 

 



प्रश्न-5 क- बाल गोमबन भगत’ पाठ में जो ग्राम्य 

संसृ्कमत की झलक ममलती है, वह आपके 

आसपास के वातावरण से कैसे मभन्न है 

?मलखखए। 

ख-मवक्रम संवत कलैंडर वषय २०२३,महीनो ंके 

नाम क्रमानुसार तैयार करें  व इस वषय आने 

वाले त्योहारो ंको अंमकत करें। 

 

 
प्रश्न-6-   सूरदास जी के मकन्ही दो पदो ंको कंठस्थ 

कररए। 

 

 
प्रश्न-7-  आप एक मवदेश यात्रा से लौटकर भारत आए 

हैं अपना अनुभव सांझा करते हुए अपने ममत्र 

को पत्र मलखखए। 
 

 
प्रश्न-8-  मकसी महान पुरुष के व्यखक्तत्व प्रकाश 

डालते हुए100 से 150 शब्ो ंमें अनुचे्छद 

मलखखए। 
 

 

 


